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Eclipse Business Connect XML Overview 
Using Eclipse Business Connect XML (referred to in this documentation as Business Connect 
XML) you can take advantage of real-time collaboration between systems, no matter how similar 
or dissimilar they may be. Use the integrated mapping utility to establish electronic trading 
relationships with your customers and vendors, as well as other distributors using XML. You can 
receive transactions, such as orders, from your customers in any XML format and translate 
outgoing XML transactions, such as order confirmations, into a format your customers' systems 
can understand. Using the HTTPs transport protocol, you can ensure your transactions and data 
are traded securely. 

Use Business Connect XML to: 

• Eliminate EDI VAN and portal charges by linking directly with customers, vendors, and 
other distributors. 

• Improve your customer service by making it easier for your customers to get what they 
want, when they want it. 

• Reduce costs associated with manual transactions and their potential errors. 

• Increase inventory visibility of slow-moving items and dead stock. 

• Sell excess inventory to other distributors, optimizing the use of your warehouse space. 

• Fill orders from other wholesalers' inventory. 

• Save time by taking advantage of existing resources. 

• Save on mapping costs by setting up your own trading partner relationships. 

• Receive orders and inquiries from your customers through supply-chain marketplaces 
such as Ariba, DataStream, MRO, MROSoup, Commerce One®, and Pantellos®. 

You might have electronic trading relationships established with customers and vendors that also 
use Eclipse through the Eclipse B2B Commerce companion product. If you conduct electronic 
business with other Eclipse users, you can still use B2B Commerce to complete those 
transactions. Use Business Connect XML to complete XML transactions with customers and 
vendors who are not using Eclipse. 

Use this guide to learn about the Business Connect XML application. Use the online Help 
available from the Contents option under the Help menu in the mapping utility to learn more 
about using entire Business Connect XML application, its components, and how to send and 
receive customer and vendor transactions using XML. 

Note: The content of this guide assumes you have a working knowledge of XML 
and Windows applications, and the Eclipse system. 
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What's New in Business Connect XML 2.0 
The following functionality is new in the Business Connect XML 2.0 release. 

  Send direct shipments using XML from within sales order entry. For more information, see 
Sending XML Direct Orders to Your Vendors. 

  Access any user-defined files that you create beyond the standard files in Eclipse. For 
example, you may want to store or send additional information about a transaction that you have 
defined in a user-defined file. Modifying the existing XML schemas to include your user-defined 
files makes those files available in the XML mapping utility. For more information, see Creating 
XML Database Schemas. 

  Add HTTP header information to any XML document you send to a trading partner. For 
more information, see Adding HTTP Headers to XML Transaction Maps. 

  Include a document type declaration to any XML document you send to a trading partner. 
For more information, see Indicating the Document Type in XML Transaction Maps. 
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Getting Started with Business Connect XML 
Consider the following when setting up an XML document trading relationship with your trading 
partners: 

• What are my trading partner's e-commerce capabilities? 

• What documents and transactions do I want to exchange with my trading partners? 

• Do my trading partners conduct business through an online portal, such as the Ariba 
Supplier Network? 

• What manual processes will this new relationship automate? 

• Who will manage the trading partner relationships going forward? 

Your answers to these questions dictate how and when you implement each trading relationship. 

What Do I Need From My Trading Partners? 
Before exchanging XML documents with your trading partners, obtain the following items for 
each transaction you plan to trade: 

• Document type definition (DTD) files – For each transaction type, the DTD is required 
to complete the transaction map using the Business Connect XML mapping utility. 

• Document specifications – Defines required elements, what data is contained in each 
element, and element descriptions. 

• Sample XML documents – Use sample XML documents to determine which fields from 
the DTD the trading partner uses and to test transactions after creating the transaction 
map. 

Meet with your trading partners to discuss the best way to map their transaction data in and out 
of Eclipse and work with them to determine the following: 

• Transactions to trade. 

• Definitions of all data fields in the XML documents. 

• The intended purpose or use of each field in the XML document. 

• Post URL for each document. 

• Workflow procedures that both parties use when processing transactions. 
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How Do I Get Started? 
After you determine which transactions you are going to trade using XML and have obtained the 
necessary documents from your trading partner, complete the following tasks to get started using 
the Business Connect XML application. 

Note: See the table of contents for page numbers to reference information about 
the following tasks. 

1. Learn how XML documents flow from your trading partner through the Eclipse system. 

• How XML documents flow through the system. 

• Example XML data flow . 

• Example XML data flow with marketplace diagram. 

2. Set system, customer, and vendor parameters in Eclipse. 

3. Learn about XML database schemas and how they form transactions. 

4. Use the Business Connect XML mapping utility to create transaction maps for each 
transaction you complete with your trading partners. 

• Learn about the Business Connect XML mapping utility and its symbols. 

• Add trading partners to the mapping utility. 

• Learn about transaction maps. 

• Create an XML transaction map for each transaction. 

• Define XML mapping selection criteria. 

• Modify incoming and outgoing data, if necessary. 

5. Send and receive transactions from your customers and vendors. 

See Also: 
Eclipse Business Connect XML Overview 
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How XML Documents Flow Through the System 
The following diagram illustrates how XML documents flow from your trading partner through 
your application server and on to Eclipse.  

If you are sending an outbound only transaction, such as an invoice to your customer, the XML 
document originates in Eclipse with no inbound component. In the diagram below, start with the 
Eclipse symbol at the bottom and follow the flow up the right side to the trading partner.  
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Example XML Data Flow 
The following diagram illustrates how XML documents for an order submit transaction flow 
from a customer flow through the system to the application server and on to Eclipse.  

In the example below, you have a transaction map defined for an order submit transaction that 
contains a received document map for an order submit transaction type, and sent document map 
for an order acknowledgement transaction type. 
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Example XML Data Flow with Marketplace 
The following diagram illustrates how XML documents for an order submit transaction flow 
from a supply chain marketplace site, or portal, through the system to the application server and 
on to Eclipse. 

In the example below, you have a transaction map defined for the following: 

• A websession transaction for the marketplace site that contains a received document map 
for an websession request and a sent document map for a websession response. 

• An order submit transaction that contains a received document map for an order submit 
transaction type, and sent document map for an order acknowledgement transaction type. 
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Business Connect XML Setup  
Set the following parameters before sending or receiving XML documents: 

• XML related control maintenance records. 

• XML Product Not Found product. 

• Remote document details. 

Set the following parameters before sending or receiving XML documents to or from customers: 

• Activity triggers for XML documents. 

• System notifications. 

• Document post locations. 

• Pricing variance parameters. 

• E-commerce IDs. 

Set the following parameters before sending or receiving XML documents to or from vendors: 

• Vendor access information. 

• Activity triggers for XML documents. 

• Document post locations. 

See the online Help for detailed instructions about how to define each of the items above. 
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Remote Document Details  
For each customer or vendor with whom you have a remote trading relationship, define 
additional document settings for each transaction you trade with them. Additional settings 
include but are not limited to indicating who the system notifies when it receives a transaction of 
a given type and setting the initial order status. 

Use Remote Trading Partner Maintenance to define details for each document type that you 
receive or send to each customer and vendor. 

For customers, some of the document details that you can set in Remote Trading Partner 
Maintenance, such as who to notify about a certain document transmissions and pricing 
variances can also be set in the customer record. Setting document details in Remote Trading 
Partner Maintenance overrides the settings defined at the customer level. 

Define details for the following remote document types: 

• Orders 

• Advanced ship notices 

• Change order requests 

• Quote requests 

• Order acknowledgements 

• Invoices 



Getting Started with Business Connect XML Rel. 8.6.2 (Eterm) 

12 © 2007  Activant Solutions Inc. All rights reserved. 

XML Schema Maintenance  
Use XML Schema Maintenance to define and access data stored in any file in Eclipse when 
using Business Connect XML to receive and send transactions. XML database schemas are 
similar to Eclipse dictionaries, in that they display data file information so you can easily view 
and understand it. XML database schemas provide additional information specific to the XML 
interface and translation of data to and from the database. Each data file in Eclipse can have a 
corresponding XML database schema. 

The system uses XML database schemas to store data when receiving transactions via XML, 
such as order submits or stock inquiries, and to retrieve data to send out using XML. Each XML 
transaction type calls one or more XML database schemas, grouped into transaction schemas. 
For example, an OrderSubmit transaction schema uses the Order and OrderDetail database 
schemas to store and retrieve the data required to submit an order in the system using XML. For 
more information, see How XML Database Schemas Form Transactions. 

Note: Business Connect XML includes a set of predefined XML transaction types 
such as order submits and remittance advice. For a complete list of the 
supported customer and vendor transactions, see Sending and Receiving 
Customer Transactions Using XML and Sending and Receiving Vendor 
Transactions Using XML. 

Your system administrator has the ability to add or modify data definitions to a schema or add 
additional schemas required for your business relationships. Eclipse personnel set up the 
following default XML database schemas. 

• Contact 

• Entity 

• Order 

• OrderAdditional 

• OrderChange 

• OrderDetail 

• OrderDetailChange 

• Product 

• Territory 
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How XML Database Schemas Form Transactions 
A transaction schema is one or more XML database schemas that define an XML transaction 
type. For example, Business Connect XML includes the following XML database schemas: 

• Order – Includes items such as the bill-to address and the payment terms. 

• OrderDetail – Contains the items being ordered, including product ID and total order 
quantities. 

An order in the system includes the information required to ship the order and the information 
about what is being purchased or sold. The OrderSubmit transaction schema contains both the 
Order and OrderDetail database schemas to create a complete order submit transaction. An XML 
database schema can be included in more than one transaction schema. For example, the Order 
and OrderDetail schemas are also used to create an invoice transaction. 

Note: Business Connect XML includes a set of predefined XML transaction types 
such as order submits and invoices. For a complete list of the supported 
customer and vendor transactions, see Sending and Receiving Customer 
Transactions Using XML and Sending and Receiving Vendor Transactions 
Using XML. You cannot create your own transaction schemas. 

A transaction can be one of the following types: 

• Inbound inquiry, such as a price and availability check. 

• Inbound update, such as an order submit or change order from a customer or an invoice 
from a vendor. 

• Outbound, such as a purchase order you are sending to a vendor. 

Transaction Schemas and the XML Mapping Utility 
Transaction schemas defined in Eclipse are available for selection as transaction types in the 
Business Connect XML mapping utility. When you create a new transaction map in the mapping 
utility, select the transaction type, or schema, in the Transaction Type fields for both the 
received and sent documents: 
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The contents of the transaction schema display as the target or source XML in the mapping 
utility, depending on the type of transaction you are creating and whether you are viewing the 
received or sent to map. In the following example, the OrderSubmit transaction schema contains 
the Order and OrderDetail XML database schemas.  
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The order detail data is stored in the table called LineItemInfo defined for the OrderDetail XML 
database schema's properties, and displays nested in the XML mapping utility. 
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Business Connect XML Mapping Utility Overview 
Use the Business Connect XML mapping utility to define how the system translates data 
transmitted using XML from your trading partners' format to a format that Eclipse can 
understand. Also use the mapping utility to define how the system translates data stored in 
Eclipse to a format that your trading partners' systems can understand. 

For example, you receive orders from a trading partner in XML. You can map data in a customer 
order submit request from a trading partner to corresponding data elements in Eclipse that make 
up an Eclipse sales order. The trading partner sends data in an XML element called 
PurchaseOrder/CustomerIdentifiers/CustomerNum. To process the information, map that 
element to the OrderSubmit/Order/ShipTo data element in Eclipse. 

  

To create an order acknowledgement response to the order request, map the Eclipse data you 
send to an XML element the trading partner can understand. 
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Adding and Editing XML Trading Partners 
Before you can create transaction maps, add the XML trading partners with whom you are doing 
business to the Trading Partners Tree in the mapping utility. The Trading Partners Tree is a way 
to organize your trading partners and their associated transaction maps. 

The trading partners display in the tree in the order that you add them. The system validates any 
trading partners you enter against the entity records in Eclipse. You can only enter customers or 
vendors that have a record defined within Eclipse. 

To make any changes to an XML trading partner's profile, access the customer or vendor record 
within Eclipse. To edit the name of the trading partner in the Trading Partner Tree within the 
mapping utility, use the instructions below. 

If a trading partner in the tree does not have any transactions defined, the system deletes the 
trading partner from the tree when you exit the mapping utility. 

Note: Editing a trading partner name is transaction map specific. That is, you can 
use the editing function to move a transaction map to a different trading 
partner in the tree. For additional information, see the procedure below. 

To add an XML trading partner in the mapping utility: 

1. Access the Business Connect XML mapping utility. 

2. From the File menu, select New Trading Partner to display the Trading Partner dialog 
box. 

3. Enter the name of the customer or vendor defined in Eclipse that you want to add as an 
XML trading partner.  

You can also enter the entity ID or the first few letters of the name and click the arrow to 
search for the customer or vendor. 

4. Click OK to add the trading partner to the Trading Partners Tree on the left side of the 
main window. 

The system validates the trading partner you entered against the existing customer and 
vendor records. If a match is not found, No Entity Found displays. 

To edit the name of an XML trading partner in the mapping utility: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. From the Edit menu, select Edit Trading Partner to display the Edit Trading Partner 
dialog box. 

4. Enter a new trading partner name and click OK. 

The system renames the trading partner, and places the selected transaction under the new 
name in the Trading Partner Tree, and removes it from the original trading partner name. 
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Note: The system validates the trading partner you entered against the Eclipse 
customer and vendor records. If a match is not found, No Entity Found 
displays. 
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XML Transaction Maps Overview 
Before you can begin using Business Connect XML to do business with your trading partners 
using XML, you need to determine what XML standard each trading partner is going to use. All 
XML standards have associated document type definition (DTD) files that explain the data 
elements in the XML documents they send you. DTD files determine what data elements your 
trading partners can receive from you. 

What is an XML Transaction? 
An XML transaction can consist of the following components: 

• An inbound request (received document), such as an order from a customer that contains 
the customer data required to enter and ship the order plus the line items for products on 
the order. 

• An outbound request (reply document), such as an order acknowledgement that lets a 
customer know that you successfully received their order request. 

A transaction can be an inbound-only transaction (such as an invoice you receive from a vendor) 
with no outbound reply document, or an outbound-only transaction (such as an invoice you send 
to your customer) with no inbound received document. 

What is a Transaction Map? 
A transaction map creates an XQuery, which the system uses to translate data from an XML 
document to a format Eclipse can understand, or to translate Eclipse data to XML. A valid 
transaction map includes a received document, sent document, or both, and mapping selection 
criteria. 

The elements defined in the DTD files from your trading partners might contain elements that 
are not named the same as Eclipse elements. Therefore, when you receive XML data from a 
trading partner or send data from Eclipse to a trading partner the system needs to know which 
elements to associate with elements in Eclipse. A transaction map associates the elements from a 
trading partner's XML document to the elements in Eclipse. 

For example, your trading partner sends the purchase order number information in an order 
request in an element called PONum. Eclipse stores PO number or order number address 
information in the CustomerPONumber element in the database. Therefore, you need to associate 
the element from the DTD file to the corresponding element in Eclipse. Using the Business 
Connect XML mapping utility, you can make that association by drawing a line between the two 
elements, as shown in the following illustration: 
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Define a transaction map for each transaction type for each trading partner with which you do 
business using XML. For instructions to create a complete transaction map, see Creating XML 
Transaction Maps. 

What if the Data Sent and Received is in Different Formats? 
At times, your trading partners might define data in a different format than how Eclipse can store 
it. For example, you have a trading partner that defines dates in the mm/dd/yy format, where 
Eclipse stores dates in the mm/dd/yyyy format. Or, you have a trading partner that defines the 
unit of measure of each as "each" where Eclipse stores the same unit of measure as "ea." 

To process XML transactions successfully, you might need to manipulate incoming or outgoing 
data to match the intended format. The system translates the data to the new format before saving 
it or sending it. You can modify each element in the Target XML column of a transaction for 
both the received document map and the sent document map using operations such as 
concatenation, adding, subtracting, and defining table-based conversions. For additional 
information about how to manipulate the XML data for translation, see Modifying Incoming and 
Outgoing XML Data. 

How Does the System Know to Use the Map I Defined? 
You might have trading relationships with many customers and vendors, therefore receiving and 
sending multiple XML documents to and from different trading partners in one day. As the 
system receives and sends XML transactions, it scans the XML documents for an element or a 
value that you define per transaction for each trading partner. This element or value tells the 
system which trading partner is sending or receiving the XML document and which transaction 
map to use to translate the XML. 
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For example, trading partner ABC Company sends you order requests with the following data 
elements within the XML: 

HeaderBlock 

From 

To 

CustomerIdentifiers 

CompanyName 

CustomerNum 

Email 

ItemList 

. 

. 

If ABC Company is the only trading partner you have that sends you an XML document with the 
CustomerNum element, you can tag that element in the transaction map as the indicator. When 
the system receives the XML, it scans the content of the request and knows it is from ABC 
Company when it reaches the CustomerNum element and also knows to use the map you have 
defined for an order request transaction from ABC Company. However, if ABC Company sends 
you multiple XML documents that contain the CustomerNum element, defining the element 
itself does not provide the system enough information to distinguish the map. In this case, or if 
you have another trading partner that uses the same element, define a value sent in the element as 
the map indicator. 

For each transaction map that you create, define an element tag as the indicator or a value as the 
indicator. 
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Mapping XML and Eclipse Data Elements 
The Business Connect XML mapping utility provides a way to connect source and target 
elements using drag and drop functionality. The mapping utility represents each connection 
using a line that you draw from the Source XML column to the Target XML column. Each 
connection is also represented in the preview pane of the mapping utility main window. For more 
information about the mapping utility, see Business Connect XML Mapping Utility Overview. 
For more information about transaction maps, see XML Transaction Maps Overview. 

Bold elements in a trading partner's DTD indicate elements that are required for the transaction. 

See the following instructions to map elements: 

• Map source and target elements (one-to-one, one-to-many, and many-to-one 
relationships). 

• Map repeating groups to non-repeating groups (many-to-one relationships). 

• Delete element mappings. 

To map source and target elements (one-to-one, one-to-many, and many-to-one 
relationships): 

1. Access the Business Connect XML mapping utility.  

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

Note: Expand the elements as necessary to access nested elements. 

3. In the Source XML column, select the element you want to connect to a target element. 

4. Click and drag the selected source element to the element in the Target XML column to 
which you want to connect the source element. 

The system draws a line from the source element through the Mapping column to the 
target element and highlights the elements mapped together.  

Note: You can also view the map in column format using the Mapping Preview 
pane. 

To map repeating groups (many-to-one relationships): 

1. Access the Business Connect XML mapping utility.  

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

Note: Expand the elements as necessary to access nested elements. 

3. In the Source XML column, select the repeating element you want to connect to a target 
element. 
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Note: Repeating groups are identified in a DTD file with a plus (+) after the 
element. 

4. Click and drag the selected source element to the element in the Target XML column to 
which you want to connect the source element. 

The Repeating Group Selection dialog box displays with the source element listed in the 
Group Name field. 

5. In the Occurrence field, indicate the occurrence number that you want to map to the 
target element. 

For example, a trading partner sends you contact telephone numbers in an element called 
ContactNumber nested in an element called Contact. The ContactNumber is a repeating 
group that can occur one or multiple times: 

• The first time it occurs, the telephone number it contains is the contact's business 
phone number. 

• The second time it occurs, the telephone number it contains is the contact's mobile 
phone number. 

• The third time it occurs, the telephone number it contains is the contact's home phone 
number. 

You want to map the contact's business phone number to a target data element. In this 
example, enter 1 in the Occurrence field to indicate that you want to map the first 
occurrence of the repeating group to capture the business telephone number. 

6. Click OK to save the information and return to the mapping utility main window. 

To delete element mappings: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

Note: Expand the elements as necessary to access nested elements. 

3. In the Target XML column, right-click the element whose connection you want to 
remove and select Remove Mapping. 

The system removes the connection between the source element and the target element. 

See Also: 
Creating XML Transaction Maps 

Valid XML Mappings and Precautions 

Duplicating XML Elements for Repeating Groups 
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Valid XML Mappings and Precautions 
When creating maps between XML elements and Eclipse database elements, every line you draw 
represents a movement of data from an XML document to Eclipse, or from Eclipse to an XML 
document being sent to your customers' or vendors' systems.  

You can create maps from almost any source element to almost any target element. Be sure to 
make the connections in a logical manner. For example, do not map elements to the BillTo 
element in Eclipse. Any data you map to the BillTo element overwrites the BillTo information 
you have stored in the customer record for the trading partner. Instead, map a customer number 
or ID to the ShipTo element. The system verifies that the incoming number or ID is valid and 
matches a customer ID or e-commerce ID in the system and then populates the BillTo 
information from the customer record.  

Note: If an XML element in the document type definition (DTD) file for a 
received or sent document has nested elements, the mapping utility might 
not allow you to draw a connection from or to the parent element. Expand 
the element to map the nested children, if necessary. 

The symbols that display for a DTD file in the mapping utility indicate what types of data can be 
transmitted in the corresponding XML document. For example, items on an order request might 
be indicated with a plus sign (+) in the mapping utility, indicating that they are a repeating group. 
The repeating group symbol means that the element can occur multiple times within the XML 
document.  

Mapping Fields with Modified Data 
As you create your transaction maps, note that any field that you map and add data modifications 
to must be contained in the XML document you send or receive. The field in the XML document 
can be blank; however, if the tag does not exist in the XML document for a mapped field, the 
system gives you an error. 

Mapping Repeating Groups 
In creating your transaction maps, take into consideration how repeating groups are stored in 
Eclipse. For example, the data element called Item in a customer's DTD file likely contains 
additional nested elements such as ItemNum and Description. You can logically map these 
elements to the ProductID and ProductKeywords database elements in Eclipse, thus, creating a 
logical map where the system can store the information from the repeating group. 

You can map the following: 

• A single element from the source to a single element in the target (one-to-one mapping). 

• A single element from the source to multiple elements in the target (one-to-many 
mapping). 

• Multiple elements from the source to a single field in the target (many-to-one mapping). 
The system concatenates each element from the source into the target element. 
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Note: A valid transaction map includes an inbound request, an outbound request, 
or both, and mapping selection criteria. Inbound and outbound documents 
can be one directional, that is, inbound only or outbound only. 

See Also: 

Required Transaction Data 

Creating XML Transaction Maps 
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Creating XML Transaction Maps 
Use the Business Connect XML mapping utility to create a relationship between the document 
type definition (DTD) files you receive from your trading partners and Eclipse data. Define the 
relationship by creating a transaction map. 

Creating an XML transaction map requires completing the following tasks: 

• Defining transaction types and selecting DTD files. 

• Mapping the received XML. 

• Mapping the sent or reply XML. 

• Defining mapping selection criteria. 

To better understand the layout of the mapping utility, see Business Connect XML Mapping 
Utility Main Window Aspects. 

Note: If you need to modify the XML data, modify the mapping characteristics 
after creating the XML transaction map. 

Defining Transaction Types and Selecting DTD Files 
Create transaction maps for each transaction you want to trade with each trading partner. Before 
you can create a transaction map, you must work with your trading partner to obtain DTD files 
and document specifications. DTD files define the data that is contained within each document 
you trade using XML. For more information, see Getting Started with Business Connect XML. 

A transaction can be a received-only transaction with no reply document, or a sent-to only 
transaction with no received document. 

To define the transaction type and select the DTD files: 

1. Access the Business Connect XML mapping utility and select the trading partner for 
which you want to define a transaction. 

2. Right-click the trading partner and select New Transaction Map to display the New 
Transaction Map dialog box. 

3. In the Transaction Name field, enter the name of the transaction, such as Purchase 
Order. The name you enter here displays in the Trading Partners Tree under the trading 
partner. 

4. In the Transaction Source field, enter the portal or marketplace the trading partner uses 
for the transaction. Entering a transaction source allows you to sort by the source in the 
remote review queues within Eclipse. 
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5. Based on the trading partner for which you are creating the transaction map, the New 
Transaction Map dialog box displays fields specific to customers or vendors. Enter the 
transaction type and DTD information in the fields for a customer or vendor transaction. 

Vendor 
Transaction Type 

Description 

Document sent to the 
vendor and a reply 
document received from 
the vendor 

(outbound with an 
inbound response) 

1. In the Transaction Type field in the Document Sent to Vendor 
area of the New Transaction Map dialog box, select the transaction 
type of the document you receive from your vendor. 
 
For example, if you are creating a map for a purchase order 
transaction, select Order Submit as the type in the Transaction 
Type field. Your selection populates the Source XML column in the 
mapping utility's main window for the sent document map and 
determines which elements in Eclipse are available. For additional 
information about how your selections display in the main window, 
see Understanding the Business Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

2. In the Vendor's DTD field in the Document Sent to Vendor area, 
enter the path to the DTD file your trading partner provided you for 
this transaction type. The DTD you enter here populates the Target 
XML column in the mapping utility's main window for the sent 
document map. Click Browse to select the field. 

3. In the Transaction Type field in the Reply Document Received 
from Vendor area, select the transaction type of the reply document 
your vendor sends to you. 
 
For example, if you are creating a map for a purchase order 
transaction, select Order SubmitResponse as the type in the 
Transaction Type field. Your selection populates the Target XML 
column in the mapping utility's main window for the received 
document map and determines which elements in Eclipse are 
available. For additional information about how your selections 
display in the main window, see Understanding the Business 
Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

4. In the Vendor's DTD field in the ReplyDocument Received from 
Vendor area, enter the path to the DTD file your trading partner 
provided you for this transaction type. The DTD you enter here 
populates the Source XML column in the mapping utility's main 
window for the received document map. Click Browse to select the 
file. 
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Vendor 
Transaction Type 

Description 

Document sent to the 
vendor, but no reply 
document received from 
the vendor 
(outbound only) 

1. In the Transaction Type field in the Document Sent to Vendor 
area of the New Transaction Map dialog box, select the transaction 
type of the document you receive from your vendor. 
 
For example, if you are creating a map for a purchase order 
transaction, select Order Submit as the type in the Transaction 
Type field. Your selection populates the Source XML column in the 
mapping utility's main window for the sent document map and 
determines which elements in Eclipse are available. For additional 
information about how your selections display in the main window, 
see Understanding the Business Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

2. In the Vendor's DTD field in the Document Sent to Vendor area, 
enter the path to the DTD file your trading partner provided you for 
this transaction type. The DTD you enter here populates the Target 
XML column in the mapping utility's main window for the sent 
document map. Click Browse to select the file. 

3. In the Reply Document Received from Vendor area, select the No 
Reply Will Be Received check box to indicate that the vendor does 
not send a reply to your request. 
 
When your vendor's system receives your XML document, it sends 
an immediate HTTP Status 200 message back to your system. The 
Status 200 message indicates that the system received your request. 
 
The Document Received From Vendor tab is disabled for the 
transaction map. 



Getting Started with Business Connect XML Rel. 8.6.2 (Eterm) 

30 © 2007  Activant Solutions Inc. All rights reserved. 

Vendor 
Transaction Type 

Description 

Document received from 
the vendor, but no 
document sent to the 
vendor 
(inbound only) 

1. In the Document Sent to Vendor area of the New Transaction Map 
dialog box, select the No Document Will Be Sent check box to 
indicate that you are not sending an XML document to your vendor. 
 
The Reply Document Sent To Vendor tab is disabled for the 
transaction map. 

2. In the Transaction Type field in the Document Received from 
Vendor area, select the transaction type of the document your 
vendor sends to you. 
 
For example, if you are creating a map for an invoice transaction, 
select Invoice as the type in the Transaction Type field. Your 
selection populates the Target XML column in the mapping utility's 
main window for the received document map and determines which 
elements in Eclipse are available. For additional information about 
how your selections display in the main window, see Understanding 
the Business Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

3. In the Vendor's DTD field in the Document Received from 
Vendor area, enter the path to the DTD file your trading partner 
provided you for this transaction type. The DTD you enter here 
populates the Source XML column in the mapping utility's main 
window for the received document map. Click Browse to select the 
file. 
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Customer 
Transaction Type 

Instructions 

Document received from 
the customer and a reply 
document sent to the 
customer 

(inbound with an 
outbound response) 

1. In the Transaction Type field in the Document Received from 
Customer area of the New Transaction Map dialog box, select the 
transaction type of the document you receive from your customer. 
 
For example, if you are creating a map for a purchase order 
transaction, select Order Submit as the type in the Transaction 
Type field. Your selection populates the Target XML column in the 
mapping utility's main window for the received document map and 
determines which elements in Eclipse are available. For additional 
information about how your selections display in the main window, 
see Understanding the Business Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

2. In the Customer's DTD field in the Document Received from 
Customer area of the New Transaction Map dialog box, enter the 
path to the DTD file your trading partner provided you for this 
transaction type. The DTD you enter here populates the Source 
XML column in the mapping utility's main window for the received 
document map. Click Browse to select the file. 

3. In the Transaction Type field in the Reply Document Sent to 
Customer area, select the transaction type of the reply document 
you send to your customer. 
 
For example, if you are creating a map for a purchase order 
transaction, select Order Submit Response as the type in the 
Transaction Type field. Your selection populates the Source XML 
column in the mapping utility's main window for the sent document 
map and determines which elements in Eclipse are available. For 
additional information about how your selections display in the main 
window, see Understanding the Business Connect XML Mapping 
Utility. 
 
The options available in the Transaction Type field are defined in 
the XML transaction schemas. 

4. In the ReplyDocument Sent to Customer area enter the path to the 
DTD file your trading partner provided you for this transaction type. 
The DTD you enter here populates the Target XML column in the 
mapping utility's main window for the sent document map. Click 
Browse to select the file. 
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Customer 
Transaction Type 

Instructions 

Document received from 
the customer, but no 
reply document sent to 
the customer 
(inbound only) 

1. In the Transaction Type field in the Document Received from 
Customer area of the New Transaction Map dialog box, select the 
transaction type of the document you receive from your customer. 
 
Your selection populates the Target XML column in the mapping 
utility's main window for the received document map and determines 
which elements in Eclipse are available. For additional information 
about how your selections display in the main window, see 
Understanding the Business Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

2. In the Customer's DTD field in the Document Received from 
Customer area, enter the path to the DTD file your trading partner 
provided you for this transaction type. The DTD you enter here 
populates the Source XML column in the mapping utility's main 
window for the received document map. Click Browse to select the 
file. 

3. In the Reply Document Sent to Customer area, select the No 
Reply Will Be Sent check box to indicate the transaction type does 
not require a response. 
 
When your system receives the XML document from your customer, 
it sends an immediate HTTP Status 200 message back to the system 
that sent the document. The Status 200 message indicates that your 
system received the request 
 
The Reply Document Sent To Customer tab is disabled for the 
transaction map. 
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Customer 
Transaction Type 

Instructions 

No document received 
from the customer, but a 
document is sent to the 
customer 
(outbound only) 

1. In the Document Received from Customer area of the New 
Transaction Map dialog box, select the No Document Will Be 
Received check box to indicate the transaction does not have an 
inbound transaction type, such as sending an invoice to your 
customer. 
 
The Document Received From Customer tab is disabled for the 
transaction map. 

2. In the Transaction Type field in the Document Sent to Customer 
area, select the transaction type for the document you send to your 
customer. 
 
For example, if you are creating a map to send an invoice to your 
customer, select Invoice as the type in the Transaction Type field. 
Your selection populates the Source XML column in the mapping 
utility's main window for the sent document map and determines 
which elements in Eclipse are available. For additional information 
about how your selections display in the main window, see 
Understanding the Business Connect XML Mapping Utility. 
 
The options available in the Transaction Type field are defined in 
XML database schemas. 

3. In the Customer's DTD field in the Document Sent to Customer 
area, enter the path to the DTD file your trading partner provided 
you for this transaction type. The DTD you enter here populates the 
Target XML column in the mapping utility's main window for the 
sent document map. Click Browse to select the file. 

 

7. Click OK to add the transaction under the trading partner in the Trading Partner Tree. 

8. If the transaction has a received document, continue with Mapping the Received XML. If 
the transaction does not have a received document, continue with Mapping the 
Reply/Sent XML. 

Mapping the Received XML 
If the transaction you are mapping contains a received document, map the received DTD 
elements from your trading partner to the Eclipse database elements available for the transaction 
type. If the transaction you are mapping does not contain a received transaction type, the 
Document Received From Customer/Vendor tab of the mapping utility is disabled. 

Note: The tab name changes based on whether you are creating a customer or 
vendor transaction map. 
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To map the request XML: 

1. If the transaction you want to map is not open, right-click the transaction in the Trading 
Partners Tree and select Edit Transaction Map. 

2. Select the Document Received From Customer/Vendor tab to display the DTD for the 
source XML and the elements in Eclipse to which you can map the data. 

3. Map elements from the Source XML column to elements in the Target XML column. 
For additional information about how to map and guidelines for creating valid mapping 
connections, see Mapping XML and Eclipse Data Elements. 

4. Modify the mapping characteristics, as necessary. 

5. If the transaction has an outgoing transaction type, continue with Mapping the Reply/Sent 
XML. If the transaction is a received-only transaction type, continue with Defining XML 
Mapping Selection Criteria. 

Mapping the Reply/Sent XML 
If the transaction you are mapping contains a document you are sending to a customer or vendor, 
map Eclipse elements available for the transaction type to the elements in the response DTD 
from your trading partner. If the transaction you are mapping does not contain a reply/sent 
transaction type, the Document Sent to Customer/Vendor tab of the mapping utility is 
disabled. 

Note: The tab name changes based on whether you are creating a customer or 
vendor transaction map. 

To map the reply/sent XML: 

1. If the transaction you want to map is not open, right-click the transaction in the Trading 
Partners Tree and select Edit Transaction Map. 

2. Select the Document Sent To Customer/Vendor tab to display the DTD for the 
reply/sent XML and the data elements in Eclipse from which you map the outgoing data. 

3. Map Eclipse database elements in the Source XML column to the data elements in the 
response DTD in the Target XML column. For additional information about how to map 
and guidelines for creating valid mapping connections, see Mapping XML and Eclipse 
Data Elements. 

4. Modify the mapping characteristics, as necessary. 

5. Define the XML mapping selection criteria. 

6. From the File menu, select Save Transaction Map to save the map. 
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Required XML Transaction Data 
When creating maps between XML elements and Eclipse database elements, some transaction 
types have data that is required to send the transaction through the system. 

• Required data for customer transactions. 

• Required data for vendor transactions. 

Required Data for Customer Transactions 
The following data is required for transactions you send to or receive from your customers: 

Transaction Type Required Data Mapped to Eclipse 
Order Submit 
Request for Quote 

• ShipTo – Can be either the Eclipse ID or the customer e-
commerce ID. 

• ProductIdentifier – Can be the UPC, product keywords, product 
ID, or the customer part number. 

• TotalQty – Defaults to one each for each product if you do not 
map data to this element, or if this element is mapped but the 
XML document contains no data. 

Product Inquiry • ProductIdentifier – Can be the UPC, product keywords, product 
ID, or customer part number.  

Order Inquiry • OrderID. 

Change Order Request • ChangeType – Free form text is allowed. 
• OrderID or CustomerPONumber. 
• Any elements that identify the changes to the order. 



Getting Started with Business Connect XML Rel. 8.6.2 (Eterm) 

36 © 2007  Activant Solutions Inc. All rights reserved. 

Required Data for Vendor Transactions 
The following data is required for transactions you send to or receive from your vendors: 

Transaction Type Required Data Mapped to Eclipse 
Order Acknowledgement 
Advance Ship Notice 
Invoice 

• OrderID. 
• PayTo or ShipFrom. 
• ProductIdentifier – Can be the UPC code, product ID, customer 

part number, or vendor catalog number. 
• TotalQty – The total quantity on the order.  

 
When creating a transaction map for an order acknowledgement 
that you receive from your vendor, map the full ordered quantity 
from the vendor's DTD to TotalQty in Eclipse. If the full order 
quantity is not filled in and not correct, the system cannot match 
the acknowledgement to an order in your system.  
 
When creating a transaction map for an invoice that you receive 
from your vendor, map the number being shipped from the 
vendor's DTD to TotalQty in Eclipse. 

Note: TotalQty and InStockShipQty are located under OrderDetail 
in the Vendor Order Acknowledgement transaction type. 

• InStockShipQty - Quantity available for shipment.  
 
When creating a transaction map for ab order acknowledgements 
that you receive from your vendor, map the total number of items 
being acknowledged from the vendor's DTD to the 
InStockShipQty in Eclipse. If the full order quantity is not filled in 
and not correct, the system cannot match the acknowledgement to 
an order in your system.  

Note: TotalQty and InStockShipQty are located under OrderDetail 
in the Vendor Order Acknowledgement transaction type. 

Direct Order Submit • ShipTo. Located under the CustomerSalesOrderID element in a 
vendor direct order submit transaction. The 
CustomerSalesOrderID element references the header information 
specific to the customer receiving the items on the direct order. 

• BillTo.  Located under the CustomerSalesOrderID element in a 
vendor direct order submit transaction. The 
CustomerSalesOrderID element references the header information 
specific to the customer receiving the items on the direct order. 

See Also: 

Creating XML Transaction Maps 

Valid XML Mappings and Precautions 
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Defining XML Mapping Selection Criteria 
You might have trading relationships with many customers and vendors, therefore receiving and 
sending multiple XML documents to and from different trading partners in one day. As the 
system receives and sends XML transaction requests, it scans the XML for an element or a value 
that you define per transaction for each trading partner. This element or value tells the system 
which trading partner is sending or receiving the XML document and which transaction map to 
use to translate the XML. 

Note: You must define the mapping selection criteria before you can save a 
transaction map. 

For each transaction map for each trading partner, define one of the following: 

• Element tag as the selection indicator. 

• Value as the selection indicator. 

Note: For a purchase order that you send to your vendor, use only the PayTo and 
ShipFrom elements as selection criteria. 

To define an element tag as the selection indicator: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. Select the Mapping Selection Criteria tab to display the available elements to define as 
map indicators. 

If the transaction map is a received transaction type, the content of the DTD for the 
received document displays in this tab. If the transaction map is a sent-only transaction 
type, the content of the DTD for the sent document displays. 

4. Right-click the element to use as the indicator and select Set Selection Criteria to 
display the Selection Criteria dialog box. 

5. Select the This Tag Exists option to indicate that the system should look only for this 
tag, not a value associated with this tag. 

6. Click OK to save the setting and return to the Mapping Selection Criteria tab. 

The option you selected displays with a red highlight. 

7. From the File menu, select Save Transaction Map to save the map settings. 

Note: To change the indicator, repeat steps 3 through 6. 
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To define a value as the selection indicator: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. Select the Mapping Selection Criteria tab to display the available elements to define as 
map indicators. 

If the transaction map is a received transaction type, the content of the DTD for the 
received document displays in this tab. If the transaction map is a sent-only transaction 
type, the content of the DTD for the sent document displays. 

4. Right-click the element to use as the indicator and select Set Selection Criteria to 
display the Selection Criteria dialog box. 

5. Select the This Tag Exists With Values option to indicate that the system should look 
for values defined within the element. 

6. In the Value field, enter the value the system uses to identify this trading partner and 
press Enter to add the value to the list. 

7. Repeat steps 5 and 6 to add additional values, as necessary. 

Note: To delete a value from the list, select the value and click the X button. 

8. Click OK to save the setting and return to the Mapping Selection Criteria tab. 

The option you selected displays with a red highlight. 

9. From the File menu, select Save Transaction Map to save the map settings. 

Note: To change the indicator, repeat steps 3 through 8. 
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Adding HTTP Headers to XML Transaction Maps 
Your trading partners might require that you add security or other information to an XML 
document in the form of an HTTP header. Including an HTTP header section in an XML 
document allows your trading partner's system to examine the information in the header prior to 
opening the XML document. An XML document can include more than one HTTP header 
section. 

When you preview the XML translation for the transaction map containing an HTTP header, the 
HTTP header displays as part of the XML in the response document. When the XML is 
transformed and sent to your trading partner, the system extracts the information and adds it to 
the HTTP headers in the HTTP transaction. 

Note: You can add HTTP header information only to transaction maps for 
outgoing XML documents. 

To add an HTTP header to an XML transaction map: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. Click the Document Sent to Customer/Vendor tab to display the DTD for the reply/sent 
XML. 

4. In the Target XML column, right-click any element and select Add HTTP Header Info 
to display the Add HTTP Header Info dialog box. 

The default element name displays.  

5. Update the element name, as needed. We recommend you use the default element name. 

6. Click OK to add the HTTP header element to the Target XML column. 

7. Map the element, as needed.  

8. Modify the mapping characteristics, as needed. 

9. From the File menu, select Save Transaction Map to save the map. 

To delete an HTTP header from an XML transaction map: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. Click the Document Sent to Customer/Vendor tab to display the DTD for the reply/sent 
XML. 

4. In the Target XML column, right-click the HTTP header element you want to delete and 
select Remove HTTP Header Info. 

5. From the File menu, select Save Transaction Map to save the map. 
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Indicating the Document Type in XML Transaction 
Maps 
Your trading partners might require that you declare the document type in a DOCTYPE element 
in XML documents you send. The DOCTYPE declaration contains a URL to the document type 
definition (DTD) or schema that defines the XML document, and tells your trading partner's 
system which DTD or schema to use to validate the XML. 

Note: You can add a DOCTYPE declaration only to transaction maps for XML 
documents you are sending to a trading partner. XML documents that you 
receive from your trading partners do not require a DOCTYPE declaration. 

To indicate the document type in an XML transaction map: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. Click the Document Sent to Customer/Vendor tab to display the reply/sent transaction 
map. 

4. In the Target XML column, right-click any element and select Add DOCTYPE 
Reference to display the Add DOCTYPE Reference dialog box. 

5. In the System ID Reference field, complete  the URL to the DTD or schema the XML 
document uses. 

• http://y.com – The URL path to the location that contains the DTD or schema. 

• /*.dtd – The DTD file name or schema name. An XML schema's file extension is 
.xsd. 

For example, if the XML document uses the basic commerce XML (cXML) DTD, 
complete the URL to read http://xml.cxml.org/schemas/cXML/<version>/cXML.dtd, 
where <version> is the full cXML versions number, such as 1.2.014. 

The declaration must be in the correct upper and lower case for the reference to work. 

6. Click OK to add the DOCTYPE reference to the transaction map. 

The first element in the Target XML column displays with a yellow icon, indicating that 
the XML document now contains the DOCTYPE element. 

7. From the File menu, select Save Transaction Map to save the map. 

To verify the DOCTYPE in the outgoing XML, preview the XML translation for 
transaction map's response XML document. To test the document post the XML to 
Eclipse. You must save the transaction prior to posting. 



Rel. 8.6.2 (Eterm) Business Connect XML 

© 2007  Activant Solutions Inc. All rights reserved. 41 

To remove the document type declaration from an XML transaction map: 

1. Access the Business Connect XML mapping utility. 

2. Right-click a transaction in the Trading Partner Tree and select Edit Transaction Map to 
display the transaction map. 

3. Click the Document Sent to Customer/Vendor tab to display the reply/sent transaction 
map. 

4. In the Target XML column, right-click any element and select Remove DOCTYPE 
Reference. 

The system removes the DOCTYPE element and the yellow icon no longer displays in 
the first element in the Target XML column. 

5. From the File menu, select Save Transaction Map to save the map. 

See Also: 

Creating XML Transaction Maps 

Defining Logical Expressions for XML Data 

Mapping XML and Eclipse Data Elements  
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Modifying Incoming and Outgoing XML Data  
Lines drawn from source to target elements in a transaction map represent a movement of data. 
At times, your trading partners might define data in a format different than how Eclipse can store 
it or the data in Eclipse might not be in a format your trading partner can understand. For 
example, you might have a trading partner that defines dates using the mm/dd/yy format, where 
Eclipse stores dates using the mm/dd/yyyy format; or you might have a trading partner that 
defines the unit of measure of each as "each," but Eclipse stores the same unit of measure as 
"ea". 

To process XML transactions successfully, modify this type of data to match the required format. 
The system translates the data to the new format before saving it or sending it. You can 
manipulate each target element of a transaction for both the received document map and the sent 
document map using operations such as concatenation, adding, subtracting, and table-based 
conversions. 

You can also add sources, such as literal statements to help identify data. For example, you 
might store e-mail addresses and other information in the Internal Notes field of an order. To 
better identify data stored and displayed in the field, you can concatenate a literal statement, such 
as Email: to the incoming data address. 

Using a combination of sources and operations, you can create a stacked operation to modify any 
XML data, even if the element does not have source data mapped to it. 

You can add the following sources to an expression: 

Source Description 
Literal Adds a text string to the XML data. For example, you can store e-mail 

addresses and other information in the Internal Notes field of an order. To 
better identify data stored and printed in the field, add literal statements to 
identify the data. 

New Line Inserts a line break in the XML data, for better readability. 

You can add the following operations to an expression: 

Operation Description 
Concatenate Links or joins data together. For example, if you are mapping several 

pieces of data to the Internal Notes field of an order, link the data 
together to form a valid expression. 

Substring Copies one part of a string, and assigns it to a variable or element. For 
example, you can extract the first four digits of a credit card number to 
identify the bank. If the string of data contains delimiters, you can also use 
the extract field operation. 

Extract fields Extracts data from a substring of data separated by delimiters into 
numbered field names. For example, if you have a string of three values 
separated by a comma (the delimiter), and you need to save the middle 
value, use the extract field operation to indicate which field within the 
delimited string you want to save. 
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Operation Description 
Table-based conversions Converts data from one format to another. For example, your trading 

partner might use the unit of measure of "each." Eclipse stores units of 
measure as two characters. Using a table-based conversion, you can tell 
the system to change the unit of measure "each" to "ea" for incoming data, 
and to change "ea" to "each" for outgoing data. 

Decimal conversions Tells the system how many decimal places to use in numeric values. Use 
decimal conversions if your trading partner sends dollar amounts or other 
numbers in a format that does not contain decimals in the actual data. 

Date conversions Converts dates into different formats. For example, your trading partner 
sends date information using the mm/dd/yy format, but Eclipse stores 
dates using the mm/dd/yyyy format. Define a date conversion operation to 
convert the format of the date element. 

Mathematical operations Adds, subtracts, multiplies, divides, or sums amounts within XML data. 

Encode or decode Base64 Encodes or decodes Base64 data. Use this type of encoding to preserve 
special characters that you might receive or send using XML. 
Note: Base64 encoding does not encrypt data. 

Extract current date and 
time 

Extracts the date and time the transaction was received or sent. Use this 
operation to extract all or a portion of a date or time stamp. 

Inversion Divides a number into 1, making a reciprocal. For example, if you 
received the number 42, assigning this operation changes the number to 
1/42. 

Uppercasing and 
lowercasing letters 

Uppercases or lowercases letters in a string of XML data. 
 

XPath selection 
 

Defines an if-then-else operation for XML data that identifies the element 
to use instead of another element if the correct conditions exist. 

Repeating group 
selection 

Defines an if-then-else operation for XML data that identifies one specific 
piece of data within an XML repeating element. 

Logical If-Then-Else  Defines a basic if-then-else operation for XML data. For example, use this 
logical expression type to define a condition in which you would need to 
change data. 
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Business Connect XML Mapping Utility Main Window 
Aspects 
As you select document type definition (DTD) files and identify what transaction types comprise 
a trading partner transaction, the system populates the Business Connect XML mapping utility 
with data from your selections. This topic illustrates how each field in the New Mapping 
Transaction dialog box relates to the data you use to create transaction maps within the mapping 
utility. 

See the following sections for information about what data displays in each: 

• Trading Partners Tree 

• Tabs for Customer Transactions 

• Tabs for Vendor Transactions 

• Mapping Selection Criteria Tab for Customer and Vendor Transactions 

Trading Partners Tree 
When you add a new trading partner, the system adds the trading partner name to the Trading 
Partners Tree: 

 
As you define transaction maps for each trading partner, the transactions display nested under the 
partner to which they belong: 
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Tabs for Customer Transactions 
The Document Received from Customer tab displays the elements in Eclipse for inbound 
documents that you receive from your customer. When defining a customer transaction map, the 
transaction type you select in the Document Received from Customer area of the New 
Mapping Transaction dialog box populates the Target XML column in the Document Received 
from Customer tab. The target XML for this transaction type contains the data elements in 
Eclipse that are available for the transaction. The elements available are defined in XML 
database schemas. 

Note: If the customer transaction does not contain a received document, such as 
an invoice, and you select the No Document Will Be Received check box 
in the Document Received from Customer area of the New Transaction 
Map dialog box, the Document Received From Customer tab is disabled. 
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The DTD you select in the Document Received from Customer area of the New Transaction 
Map dialog box populates the Source XML column in the Document Received From 
Customer tab. The source XML for this transaction type contains the data elements defined in 
the DTD from your trading partner. The data elements display in the order they are defined in the 
DTD. 
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The Reply Document Sent to Customer tab displays the data elements in Eclipse for 
documents you send to your customer. When defining a transaction map, the transaction type 
you select in the Reply Document Sent to Customer area of the New Transaction Map dialog 
box populates the Source XML column in the Reply Document Sent to Customer tab. The 
source XML for a sent document contains the data elements in Eclipse available for the 
transaction. The elements available are defined in XML database schemas. 

Note: If the customer transaction does not contain a sent document and you select 
the No Document Will Be Received check box in the Reply Document 
Sent to Customer area of the New Transaction Map dialog box, the Reply 
Document Sent to Customer tab is disabled. 
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The DTD you select in the Reply Document Sent to Customer area of the New Transaction 
Map dialog box populates the Target XML column in the Reply Document Sent to Customer 
tab. The target XML for this transaction type contains the data elements defined in the DTD file 
from your trading partner. The data elements display in the order they are defined in the DTD. 
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Tabs for Vendor Transactions 
The Document Sent to Vendor tab displays the elements in Eclipse for documents you send to 
your vendor. When defining a transaction map, the transaction type you select in the Document 
Sent to Vendor area of the New Transaction Map dialog box populates the Source XML 
column in the Document Sent to Vendor tab. The source XML for a sent document contains the 
elements in Eclipse available for the transaction. The elements available are defined in XML 
database schemas. 

Note: If the vendor transaction does not contain a sent document and you select 
the No Document Will be Received check box in the Document Sent to 
Vendor area of the New Transaction Map dialog box, the Document Sent 
to Vendor tab is disabled. 
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The DTD you select in the Document Sent to Vendor area of the New Transaction Map dialog 
box populates the Target XML column in the Document Sent to Vendor tab. The target XML 
for this transaction type contains the data elements defined in the DTD file from your trading 
partner. The data elements display in the order they are defined in the DTD. 
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The Reply Document Received from Vendor tab displays the elements in Eclipse for 
documents that you receive from your vendor. When defining a vendor transaction map, the 
transaction type you select in the Reply Document Received from Vendor area of the New 
Transaction Map dialog box populates the Target XML column in the Reply Document 
Received from Vendor tab. The target XML for this transaction type contains the data elements 
in Eclipse that are available for the transaction. The elements available are defined in XML 
database schemas. 

Note: If the vendor transaction does not contain a received document, and you 
select the No Document Will Be Received check box in the Reply 
Document Received from Vendor area of the New Transaction Map 
dialog box, the Reply Document Received From Vendor tab is disabled. 
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The DTD you select in the Reply Document Received from Vendor area of the New 
Transaction Map dialog box populates the Source XML column in the Reply Document 
Received from Vendor tab. The source XML for this transaction type contains the data 
elements defined in the DTD from your trading partner. The data elements display in the order 
they are defined in the DTD. 
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Mapping Selection Criteria Tab 
Use the Mapping Select Criteria tab to indicate to the system which map to use when it 
receives or sends an XML document. If the transaction map contains an inbound, received 
transaction type, the DTD file you select for the received XML document in the New 
Transaction dialog box populates the Mapping Selection Criteria tab. If the transaction map 
does not contain an inbound transaction type and is outbound-only, the DTD you select for the 
outgoing, sent to document populates the Mapping Selection Criteria tab. For additional 
information, see Defining Mapping Selection Criteria. 
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Business Connect XML Mapping Utility Symbols 
Your trading partners' document type definition (DTD) files might contain one or more of the 
following symbols that indicate the occurrence of each element in the DTD. These symbols 
display in the Business Connect XML mapping utility when you expand the source or target 
XML that represents the DTD from your trading partner: 

Symbol Description 
* A one-to-many relationship can be mapped for the element. The element can appear in 

the XML document once, more than once, or not at all. 

+ A repeating group, that is, the element can occur in the XML document once or more 
than once, such as, items on an order. 

? An optional piece of data, such as an extension for a telephone number. The element 
might appear in the XML document zero or one time. 

Blank The element must appear only once in the XML document. 

 
An XML attribute associated with the element. 

Bold The element is required for the transaction. 

 

The Business Connect XML mapping utility also contains the following symbols: 

Symbol Description 

 Trading partner in the Trading Partner Tree. Transactions are listed under each trading 
partner. 

 Transaction in the Trading Partner Tree, or a trading partner that does not have 
transactions defined yet. 

 The target XML element has operations assigned to modify incoming or outgoing data. 

 The target XML element has a source element mapped to it, with no additional data 
modifications. 

   

 

The target XML element has a nested element to which a source element is mapped. 
Expand the element to see the nested elements. 

 Multiple target elements are mapped to a source element. This symbol displays in the 
Mapping Preview pane. 

 The XML document contains a DOCTYPE declaration. 

 The element has a single data conversion applied. This symbol displays in the Mapping 
Preview pane. 

 The element has multiple data conversions applied. This symbol displays in the 
Mapping Preview pane. 
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Symbol Description 

 A source, such as a Literal, in the Operation Stack field in the XML 
Mapping Conversion Editor dialog box. 

 An operation, such as concatenation, in the Operation Stack field in the 
XML Mapping Conversion Editor dialog box. 
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Sending and Receiving Customer Transactions Using 
XML 
Using the settings you define in Eclipse and the transaction maps you set up for trading partners 
in the mapping utility, the system processes transactions and routes them to review queues where 
appropriate. 

Before sending or receiving XML from customers, ensure you have completed the following 
setup for the customer records in Eclipse. For additional system setup requirements, see Business 
Connect XML Setup. 

• Set system notifications for XML customer transactions. 

• Set post locations for XML customer transaction documents. 

• Set XML activity triggers. 

• Define pricing variance for XML customer transactions. 

Use Business Connect XML to receive the following transaction types from customers with 
whom you do business using XML documents: 

• Order submits 

• Product inquiries 

• Change order requests 

• Requests for quotes 

• Punch-out setup requests 

• B2B connection test 

Use Business Connect XML to send the following transaction types to customers with whom you 
do business using XML documents: 

• Order acknowledgements 

• Advance ship notices 

• Invoices 

For information about additional setup considerations, and how to process these transactions 
using Eclipse, see the Business Connect XML online Help. 
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Processing B2B Connection Test Transactions From 
Your Customers 
If you are using the Eclipse B2B Commerce companion product for electronic trading with 
customers who also run Eclipse, your system processes test transactions to verify the 
communication connection between your Eclipse system and your customer's Eclipse system. 
When a trading partner submits a B2B connection test to your company using XML, your system 
does the following: 

• Translates the XML request according to the settings in the inbound customer B2B 
connection test transaction map for the trading partner. 

• Verifies the basic credential information passed in the transaction. 

• Sends a successful HTTP 200 response back to your customer. 

• Archives the incoming XML document in Remote Archive Maintenance. 

See Also: 
Creating XML Transaction Maps 

Remote Archive Maintenance Overview 

Sending and Receiving Customer Transactions Using XML 
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Sending and Receiving Vendor Transactions Using 
XML 
Using the settings you define in Eclipse and the transaction maps you set up for trading partners 
in the mapping utility, the system processes transactions and routes them to review queues where 
appropriate.  

Before sending or receiving XML from vendors, ensure you have completed the following setup 
for vendor records in Eclipse. For additional system setup requirements, see Business Connect 
XML Setup. 

• Set vendor access information for XML documents. 

• Set vendor activity triggers for XML documents. 

• Set post locations for XML vendor transaction documents. 

Use Business Connect XML to receive the following transaction types from vendors with whom 
you do business using XML documents: 

• Purchase order acknowledgements 

• Advance ship notices 

• Invoices 

• Product inquiries 

Use Business Connect XML to send the following transaction to vendors with whom you do 
business using XML documents: 

• Purchase orders 

• Change order requests 

• Direct orders 

• B2B connection tests 

For information about additional setup considerations, and how to process these transactions 
using Eclipse, see the Business Connect XML online Help. 
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Sending XML Direct Orders to Your Vendors 
A direct order is similar to a purchase order that you send to your vendor to request items for 
your warehouse to fill outstanding orders. However, using a direct order, you instruct the vendor 
to ship the ordered items directly to your customer, not to you.  

The system transmits direct orders to vendors using XML when you set the print status on a 
direct sales order generation to 2 and select the Direct Order Submit transaction document. The 
direct sales order generation contains the items that you are acquiring from your vendor to fill the 
order. You can also send a direct order to your vendor using the Eclipse B2B Commerce screen 
in sales order entry if you are procuring items for an order and want to ship them directly to your 
customer. 

Note: Before the system can send a direct order to a vendor, create an XML 
transaction map for a direct order transaction type that contains the ship-to 
and bill-to information for the order, set activity triggers, and define 
document post locations for the vendor. 

When you send a direct order using XML, the system verifies that the vendor has a transaction 
map defined for an outbound direct order transaction type and archives the XML sent in Remote 
Archive Maintenance. 

To send an XML direct order to your vendor: 

1. Display an open order in Sales Order entry. 

2. Display the order's Status screen and select the direct order generation you want to send. 

3. In the Prt field for that generation, enter 2 for B2B Transmit. 

Note: You can also send a direct order to your vendor using the Eclipse B2B 
Commerce screen in sales order entry if you are procuring items for an 
order and want to ship them directly to your customer. 

4. Press Esc to exit the window, process the order, and send it to the vendor. 

5. If prompted, select the Direct Order Submit document. 

The system verifies that a valid XML transaction map exists for a purchase order for the 
trading partner and translates the Eclipse data using the settings in the map. 

See Also: 

Creating XML Transaction Maps 

Remote Archive Maintenance Overview 

Sending and Receiving Vendor Transactions Using XML 
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Testing Vendor B2B Connections with XML 
If you are using the Eclipse B2B Commerce companion product for electronic trading with your 
vendors who also run Eclipse, test the B2B communication connection between your Eclipse 
application and your vendors from the Vendor B2B Setup screen in Eclipse. When you test the 
vendor B2B communication, your system and your vendor's system do the following: 

• Your system translates the XML request according to the settings in the outbound vendor 
B2B connection test transaction map. 

• Your vendor's system verifies the basic credential information passed in the transaction 
and sends a message back to your system. If the connection test was successful, your 
vendor's system sends HTTP 200 response back to your system and Eclipse displays the 
following message in the Vendor B2B Setup screen: Good Customer Number and 
Password. Connection was successful.  

If the connection test was not successful, Eclipse displays troubleshooting information in 
the Vendor B2B Setup scree. For example, the message might indicate that the password 
you specified is invalid, or the web server would not allow a certain method. The 
message often displays detailed HTML information that you can use to determine the 
connection problem. 

• Your system archives the outgoing XML document in Remote Archive Maintenance. 

To send a vendor B2B connection test transaction: 

1. From the Files menu, select Vendor to display the Vendor Maintenance screen. 

2. Open or create a vendor maintenance record. 

3. Use the WWW hot key to display the Internet Information Maintenance screen. 

4. Use the B2B Commerce hot key to open the vendor's Eclipse B2B Commerce Vendor 
Maintenance screen. 

6. Enter the login information you use to access the vendor’s web site: 

Field Description 
Customer ID Your company-assigned login identification. 

Login The login ID for the customer. 

Password Your company-assigned login password. 

7. Use the B2B Post URL hot key and select Connection Test. 

The system uses the location in the Default transaction type if all transactions' posts go to 
the same location for the vendor. If the vendor requires the connection test posts to go to 
different locations, set the URL for the connection test URL. If not, use the default post 
URL. 

8. In the B2B Post URL field, enter the post location for XML documents for the customer. 

9. Press Esc until you return to the Vendor Maintenance screen. 
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10. Press Esc to save the vendor record and exit the screen. 

11. Use the Test Connection hot key to test your connection access to the vendor. The 
system attempts to connect to the vendor's URL, using your login information. 

See Also: 

Creating XML Transaction Maps 

Remote Archive Maintenance Overview 

Sending and Receiving Vendor Transactions Using XML 
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